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User Manual for the Seagull Glide Wireless Dashboard Telemetry System and Recorder
 

Patent Pending 
 

Document Version 3.1 

 

Please read this manual before using your new system. 
 

Thank you for your purchase!   This instruction manual will guide you through the installation and operation of 

your Seagull Glide Wireless Dashboard Telemetry System.    

 

The Glide System is the first instrument designed for models that supports electronic Total Energy Compensation 

(derived from airspeed), and that lets you change key variometer parameters while your model is in flight!    Many 

other features are provided with the Glide System, making it an incredibly versatile all-in-one instrument. 

 

Please read the entire manual carefully before proceeding.    If, after you read the manual (including the 

Troubleshooting sections!) you have further questions or problems, please visit our web support page for additional 

support options, at http://www.eagletreesystems.com/Support/support.html.    Note that the latest version of this 

manual is available in PDF form from the Support page of our website.    

Intended Uses  
 

The Seagull Glide System is designed to be used to transmit data in Radio Controlled model Gliders, or on other models where high 

resolution altitude and airspeed measurement and variometer features are needed. 

Packing List 
 

Your Seagull Glide System includes the Wireless Telemetry Data Dashboard Receiver, the Wireless Telemetry transmitter, Flight 

Data Recorder,  approximately 3 feet (1 meter) of Pitot Tube hose, plastic Pitot Tube, battery Y-connector, USB cable, plastic clip for 

mounting dashboard to radio antenna, and Windows CD. 

 

If you purchased  the Glide Recorder only (GDR-KIT-STD), the Wireless Telemetry Transmitter and Wireless Telemetry Data 

Dashboard Receiver are NOT included. 

 

Optional expanders for measuring Temperature, RPM, Servo movements, G-Force, Exhaust Gas Temperature, Electric Motor 

Current/Voltage, and other parameters are available from Eagle Tree Systems.    An External Hookup Kit is also available if you want 

to download data from your model without removing the wing. 

 

Steps to Follow 
 

This manual is divided into two sections, Basic and Advanced.   The Basic section describes minimal installation and setup of the 

Glide unit.  These steps do not require a computer.   The Advanced section describes other features and options available, and does 

require a computer.     

 

NOTE: It is recommended that the basic installation be attempted first to verify system operation, before connecting the device to a 

computer in the advanced section. 

 

Installation and use of your Seagull Glide system will be quite easy and enjoyable if you follow these few steps: 

 

1. Read through the manual to understand the warnings, determine the installation and setup sequence, etc.  

2. Install the system as described in the Basic setup instructions below.   
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3. If desired, configure the Seagull system with your PC, as described the Advanced setup instructions below. 

4. Bench and range test your model, and have fun! 

 

Your Seagull Glide system has been pre-configured for the following options:   Variometer,  Airspeed, Altitude, Climbrate, Receiver 

voltage,  received packet percentage, and signal strength.    Other parameters may be displayed (and alarms programmed) by 

connecting the unit to a PC and running the Windows application.   See the Advanced section for instructions for reconfiguration. 

Important Warnings 

• Make sure you have the right transmitter for your area.  You are responsible for determining 
whether you may use your transmitter in your country!   See the transmitter specifications below for 

information on frequency and power output.    In general, transmitters marked EU or CE are suitable 

for use in Europe, and transmitters marked FCC are suitable for USA operation.    

• It is very important that you “Antenna Down” range check your model per your radio 
manufacturer’s instructions after installing or reconfiguring any electronic equipment, and generally 

before each operation.    If you have range issues, see the Troubleshooting section, or email 

support@eagletreesystems.com.    

• The Seagull system is to be used only as described in the “Intended Uses” section below.   Other uses 
are not supported, and uses where loss of life or injury may result are expressly forbidden. 

• Operating your model requires that you keep your eyes on it and give it your full attention.   Looking 
at the Seagull LCD display while the model is in operation is strongly discouraged.   Use the 

programmable audible alarms, or have a buddy look at the display, as necessary. 

• The Seagull Transmitter and Dashboard Receiver antennas are very flexible, but use care that you 
don’t mount them in such a way that they could cause eye or other bodily contact injury.     

Basic Installation and Setup Instructions 
 

This section describes the minimal setup and configuration required to use your system.    No computer is required for this section. 

 

Install your Data Acquisition Module (Recorder) 
 

NOTE: The recorder’s label has a handy color coded means of indicating the polarity of the various connectors.    The red dots on 

the label, which are on only one side of the text corresponding to each input,  indicate on which side of the plug the red wire 

should go. 

 

Connecting the Airspeed Pitot Tube 
 

WARNING:  If you mount the Pitot Tube in such a way that it might induce drag on your model, you need to make sure that 

it won’t cause the model to become unstable during flight! 

 

The Recorder uses pressure differential via a Pitot Tube (a piece of small fuel tubing which you will fit with a short piece of plastic 

insert, supplied) to measure airspeed, just as full size planes do.     The static port of the pitot sensor for the Flight Data Recorder V2 is 

located inside the Recorder. 

 

The length of the tube should not have a significant effect on airspeed measurement, so it should be no problem to lengthen or shorten 

the supplied tube.  Also, replacing the plastic insert with metal or other rigid tubing should not significantly affect airspeed 

measurement. 

 

NOTE:  It is of course not necessary to use the Pitot Tube with the Recorder if you are not interested in measuring airspeed – the other 

functions of the Recorder will work without airspeed readings. 
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NOTE:  Additional Pitot Tube kits are available for purchase on our website. 

 
Method A: If the airplane’s fuselage is relatively sealed, with no large “ram” air openings in the nose of the plane, you can likely 

obtain good readings by just leaving the static airspeed connections unconnected.  

 

Method B:  A true static pickup can be created with a piece of brass tube (not included).   The diameter of this tube is not critical.   

See Figure 1 for details of this method.   To create the static pickup, you will need to drill 4 small holes into the side of the tube, 

spaced equally around the circumference of the tube. If it is difficult to drill all four holes around the tube in a circle, two of the holes 

can be drilled farther forward than the other two.   Also, a larger diameter tube can be used to make this easier, if the extra weight can 

be accommodated.    

 

These holes should be drilled 1.5” or more from the front of the tube, but should not be too close to the tube mount.     The holes 

should be approximately 1/32” in diameter, and should be deburred if there are burrs from drilling.    Once the holes are drilled, the 

front opening of the tube should be plugged with epoxy or other.    The static tube is mounted parallel to the direction of travel, near 

the pitot tube, as shown in the below figure.    

 

Method C: A static source can be obtained from the side of the fuselage, with the rubber tube (or a short piece cut from the pitot tube) 

mounted absolutely flush with the side of the fuselage, so that the mouth of the tube is pointing perpendicular to the direction of plane 

travel. The location of the static tube should be chosen so that the least disturbance of air possible occurs. 

 

Altitude Measurement 
 

The Seagull Glide system measures altitude via a sensor inside the unit.   Altimeters measure slight pressure differences to determine 

elevation.   Since these pressure differences are relatively small, it’s important that the airplane’s internal pressure doesn’t vary much 

due to propwash or moving through the air.    Such variation can occur if the front portion of the plane has an opening that causes air 

to compress inside of the plane when air is forced into this opening.    

 

If you get lots of altitude variation at level flight, check to see if there are openings in the front of your plane that allow air to enter 

and increase pressure inside the fuselage.   If your plane is not airtight or at least sealed well up front, you may have altitude 

jumpiness, since the altimeter measures changes in air pressure.   If you have this problem and/or want very accurate altitude 

measurements, a static source can be obtained as follows: 
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1. Remove the Recorder’s case top. 

2. There is a predrilled hole to accommodate an external altitude tube.   Look at the back of your recorder cover, and use an x-

acto knife to carefully cut the label around the hole.     

3. You can now install an external altimeter tube to the nipple of the altimeter sensor just like you do the pitot tube for airspeed, 

using an extra piece of rubber pitot tube, or similar.   Choose either option A, B, or C for the static source, as described in the 

Airspeed section above.  If you have installed a static airspeed tube already, that same static tube can be shared with the 

altitude static source, by using an optional ‘T’ fitting, as shown in Figure 1. 

 

Powering the Glide Recorder  
 

IMPORTANT: If you are using the 1 Watt 900 MHz Transmitter, special care must be given to ensure that the  

supplied power remains between 5V and 5.75V. The 1 Watt Transmitter will stop transmitting if powered above 5.75V, and  

will reduce power output to 500 mW (when in High Power mode) if the voltage drops below 5V.  

 

The battery harness is the cable with a Futaba style  

male connector on one end, and male universal  

servo connector on the other end. To power the  

system, plug the Futaba end into any one of the  

recorder’s servo slots. The universal male end of  

the harness can plug into a spare channel of your  

 

receiver, or you can connect a separate battery to  

the unit. The battery must be at least 4.5 volts to  

power the recorder. 

 

 

Installing the Seagull Transmitter in your Model 
 

Choose a location in your model to install the transmitter.    The transmitter is normally mounted with Velcro or double sided tape.  

Ideally, the transmitter will be installed with its antenna and body as far away from your radio receiver (RX) as possible, with the 

antenna protruding at right angles with your RX antenna, to reduce the possibility of interference.   For example, if you have a model 

plane with the receiver mounted horizontally along the plane’s fuselage, mount the Seagull so that the antenna is protruding from the 

model vertically, as far forward of the RX antenna as possible.    Best reception will be obtained if the Seagull antenna is vertical. 

 

 

Connecting the Seagull Transmitter to your Data Recorder 
 

Ensure that the Recorder is not powered when connecting the transmitter, and ensure that the red wire of the transmitter  

cable corresponds with the red dot on the port label (to the right of the connector).     Plug the Seagull Transmitter cable into the 

“Expansion” port on your Recorder, as shown in Figure 1. Install the transmitter in the upper row of pins, as shown in the figure.  

 

Using the Seagull Wireless Dashboard 
 

The Seagull Dashboard Receiver (the Dashboard) operates from a standard 9V 

battery. The battery installs in the back snap-off compartment of the Dashboard. 

Approximately 12-14 hours continuous use is typical with an alkaline battery. 

Approximately 3-4 hours of continuous use is typical with the 2.4 GHz and 900 

MHz/1 Watt systems. Optionally, any battery of between 5-16 volts can be used to 

power the Dashboard. Rechargeable 9V batteries will work, but the run time will be 

significantly reduced.. 

 

Note:   If the Dashboard will be unused for long periods, it is a good idea to remove 

the battery. 

Note:  When removing the battery clip, use your thumb to pop the clip off from the 

side without the wires.   Pushing on the wire side can break the battery clip or the 

wires. 

 

Variometer Function:  Your Dashboard contains a sophisticated Variometer, employing electronic Total Energy Compensation, 

based on changes in Airspeed.    Basic variometers do not support total energy, which means that “stick thermals” are reported by the 

variometer if you descend or ascend due to elevator movement.     Standard total energy variometers reduce the effects of moving the 
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elevator by monitoring the pitch of the aircraft, which requires an additional probe to be mounted.   The Seagull Glide 

system uses the airspeed pitot tube for total energy calculations, requiring no additional tube. 

 

The variometer produces a varying tone, which changes as you ascend or descend at different rates.   When ascending, the tone will be 

broken, with the tone frequency increasing as the rate of ascent increases.   When descending, the tone will be continuous, with the 

tone frequency decreasing as your rate of descent increases. 

 

Several parameters of the variometer are adjustable.   See the Configuration Menu section below for more information. 

 

The Dashboard includes a small speaker, or a set of standard headphones or ‘earbuds’ can be plugged into the dashboard for noisy 

areas.    Note that the headphone volume is fixed. 
 

USB Connection: The USB cable supplied with your Recorder connects to the Dashboard at this port.   Note that the RED wire of the 

USB cable goes up, as shown by the red dot above “USB” on the Dashboard label. 

 

LCD Display: The 16 x 2 LCD character display is easily programmed to display up to four model parameters per screen page.     

 

Pushbutton 1 (up arrow):   The leftmost pushbutton advances to the next LCD screen page.   Holding down this button brings up the 

configuration menu. 

 

In Menu mode, this button increases the value of the parameter. 

 

Pushbutton 2 (down arrow):    This pushbutton returns to the previous LCD screen page. 

 

In Menu mode, this button decreases the value of the parameter. 

  

Pushbutton 3 (Disp/Reset Max):  pressing this pushbutton briefly causes the Dashboard to toggle between Max and Live modes.   In 

Max Mode, the parameters displayed have a carat (^) next to them to indicate they are the max parameters recorded.   Note that some 

parameters are not captured in Max Mode – these are displayed with “***”.    Figure 6 shows which parameters have the Max feature.   

In Live Mode, the data displayed are the live values received from the Transmitter. 

 

Holding down this pushbutton for approximately two seconds zeros the Max parameters.     

 

In Menu Mode, this pushbutton takes you to the next menu item. 

 

Pushbutton 4 (Mute/Power): When the unit is in operation, pressing this button mutes or unmutes the audio portion of the 

Dashboard, as well as turning off power.    What happens when the mute button is pressed briefly depends on the state of the audio 

system: 

• If the audio is unmuted, and no alarm beeps are in progress, pushing the button causes the Dashboard to go into “Mute All” 

state.   No beeps will be heard in this state. 

• If the audio is in “Mute All” state, pushing the button causes the Dashboard to go into “Unmute” state.   All beeps will be 

heard in this state. 

• If the audio is unmuted, and alarm beeps are in progress, the Dashboard will go into “Mute Current” state.   This state mutes 

only the currently sounding alarm to be muted.  All other beeps will be heard, and the currently sounding alarm will be heard 

once the alarm condition occurs again. 

 

When the Mute/Power button is held for approximately 2 seconds, the Dashboard is powered off. 

Note:  Pressing any of the keys when the power is off powers up the Dashboard. 

Note:  The Dashboard will power off after approximately 5 minutes when no signal is being received, and no buttons are pressed. 

 

Configuration Menu 

Holding the Pushbutton 1 (up arrow) button on the SRX puts the unit in Menu mode.   Holding it again takes you out of Menu mode.  

In Menu mode, pressing/releasing up and down arrows varies the parameter, and pressing Pushbutton 3 (Disp/Reset Max) takes you to 

the next menu item.   All of these parameters can be selected and changed while your model is in the air! 

 

Here is a description of the menus: 

• “Vario Avg Secs” – This setting controls the averaging period of the variometer, in 10ths of a second units.   For faster 

response, lower periods are recommended, but in rougher air longer periods may be required to avoid false alarms.   Pressing 

up/down arrows changes the averaging period. 

• “Vario Sinkrate” – this setting controls the minimum sinkrate.    Normally, this would be set to the standard sinkrate of your 

model, i.e., the rate at which it descends in smooth air with no thermals.   When you descend at a rate greater than this 
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sinkrate, the variometer will start to sound, as described in the “Variometer” section above.   Pressing up/down 

arrows changes this parameter.   

• “Vario Climbrate” – this setting controls the minimum climbrate.  When you ascend at a rate greater than this climbrate, the 

variometer will start to sound, as described in the “Variometer” section above.   Pressing up/down arrows changes this 

parameter.   

• “Vario Freq Shift” – This setting changes the amount the pitch changes as the climbrate increases/decreases.   If you are not 

hearing enough change, increase this parameter, and vice versa for too much frequency change. 

• “Total Energy %” – this adjusts the scaling of the Total Energy Compensation calculation.   100% means that Kinetic Energy 

is converted into Potential Energy directly, i.e., any change in airspeed is assumed to directly negate any change in altitude.  

Less than 100% reduces the degree which airspeed change affects Total Energy, and increasing it above 100% increases the 

amount.     

Ready for Action! 
 

Now that you have completed basic installation and configuration of the Seagull system, it’s time to actually use it!     

 

Power on your model as you normally would, turning on your radio transmitter before powering up the model.    The Recorder’s LED 

should blink normally (one flash repeating) after powering up the model.     

 

NOTE: Always wait 15 seconds after powering down your Recorder, before powering it back on.  This will ensure that the 

Recorder and transmitter start properly. 

 

Next, power on your Dashboard.   Since the Dashboard calibrates several of the parameters on powerup, always turn on your model 

first, then turn on your Dashboard (or turn the Dashboard power off and on after you model is turned on). 

 

At this point, the Dashboard should display live data.   By default, page one of the data displayed contains Airspeed, Altitude, 

Variometer climbrate (TE compensated), and  Receiver voltage.   Page two of the data displayed contains signal strength, received 

packet percentage, and raw climbrate (non-TE compensated).     If the Dashboard displays “No Signal”, consult the Troubleshooting 

section below. 

 

Once the Seagull system is communicating, consider how you will mount and use the Dashboard.     The Dashboard can be mounted 

to your radio transmitter, using the supplied plastic clip with adhesive.   Just remove the adhesive backing from the clip, mount the 

clip on the back of the dashboard, and clip the ring around your radio’s antenna.   You can further stabilize the dashboard with a strip 

of Velcro on the dashboard’s bottom.   Or, just hand the dashboard your crew or buddy to monitor your run, or just place it in your 

shirt pocket.     It is a very bad idea to take your eyes off your model during operation! 

 

DON’T FORGET TO “ANTENNA DOWN” RANGE CHECK YOUR MODEL AFTER INSTALLATION, AS DESCRIBED 

IN YOUR RADIO MANUAL!     

Adjusting the Variometer 
 
The Averaging Period, Sinkrate, and Total Energy Compensation percentage should be adjusted depending on wind conditions, plane 

geometry, etc., so that the unit is silent when you are flying in still air but descending normally at your plane’s standard sinkrate.     

See the above section for instructions on how to change these parameters, even while the plane is flying. 

 

Typically, you would start with a very small Variometer Average Seconds (perhaps 0.2), and a sinkrate of perhaps 150.   If the unit 

“sqawks” or “honks” a lot when flying outside of thermals, start gradually increasing the average seconds until it doesn’t sqawk.    

Then, adjust the Minimum Sinkrate parameter until the unit just barely does not make a constant tone as you descend due to gravity 

when flying level.      We recommend that the above adjustments be made with the Total Energy percentage set to 0%. 

 

The total energy % should be adjusted (after doing the above adjustments) so that “stick thermals” are minimized.   We recommend 

starting at 100%, then adjusting the value up or down, so that you can pull back on the elevator and not hear lift tones. 

 

Happy flying! 
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Advanced Installation and Setup Instructions 
 

This section describes more advanced setup and configuration.   A computer is required for 

this section, and some features listed require optional accessories. 

 

Installing Temperature Sensor(s)  
 

If you purchased optional Temperature Sensors, you will be able to monitor up to two 

temperatures with your system.   Plug the Futaba style connector from the sensor into the 

recorder as shown in Figure 1.  

Note:  the Temperature Sensor lead can be easily extended with a standard servo extension 

cable. 

 

Installing the RPM Sensor 
 

If you purchased the optional RPM Sensor kit, you will be able to measure the RPM of your 

motor.   Installing the RPM sensor and magnets is the most challenging part of installation, 

but is relatively easy once a good mounting location is determined.  Refer to our website’s 

Flight support page at http://www.eagletreesystems.com for pictures of example 

installations.    

 

First find a suitable location on your engine’s motor to attach either one or two small magnets and RPM sensor.   Typically, the prop 

washer or prop hub are ideal locations.   This will of course vary with make and model of plane.  Make sure the magnets are mounted 

on some structure that doesn’t “flop around,” as the magnets could hit the sensor in this case.     The RPM sensor must be mounted so 

that it does not move around, and is within 1-2 mm of the two magnets as they spin.    On typical plane installations, there’s usually a 

place where the back of the sensor can be glued to a flat surface under or over the hub which has the magnets mounted.    The 

Recorder kit includes four magnets.  That provides you with up to 3 spares.    

          

Installing Magnets 

 

Once you have determined where to install the magnets, decide whether you will drill a hole so that the magnets will mount flush with 

the surface, or if you will just glue the magnets to the surface.    Though somewhat more difficult and permanent, mounting the 

magnet flush with the surface is the best long term approach, since the mounting will be much more rugged, and the risk of imbalance 

due to not mounting the magnets exactly 180 degrees apart is reduced.    In fact, if the magnet is mounted flush in another metal 

material, it is quite possible that no shaft imbalance will occur if you only mount one of the magnets total.    

To flush mount the magnets, drill a hole just slightly larger than the diameter of the magnet size you choose, and of the same depth as 

that magnet.    If you decide to surface mount the magnets, thoroughly clean this area and lightly scuff it to improve adhesion.     Glue 

the magnets with the side marked with a red line facing inward (hidden), using epoxy, or other strong, suitable glue.  It’s important 

that the red line on the magnets faces away from the sensor once the sensor is installed.    The magnets should be glued 180 degrees 

apart to keep the shaft in balance. 

 

WARNING:  make sure that the magnets are glued sufficiently so that they will not detach and create a hazard, and always 

wear safety glasses when your engine is running!     It is also a good idea to put a piece of heatshrink tubing or electrical tape 

around the magnets, to further secure them. 

 

Using Existing Magnets 

 

Note:  if your engine already has magnets mounted for some other purpose, there’s a good chance you can use them.   Take one of the 

magnets included with your recorder, and put that magnet up against the previously mounted magnet.   If the red line of the Recorder 

magnet faces down so that the sensor can be mounted facing the side of the magnet with no red line, mount the sensor with the printed 

side toward the magnet.    If the side of the magnet with the red line is visible when on top of the previous magnet, the polarity is 

reversed.   This should work correctly if you install our sensor backwards (printed side of sensor away from magnets), though we have 

not tried it. 

 

We are often asked whether existing magnets on spark ignition engines can be used.  The answer is “yes” in most cases, if you can 

install the sensor near enough to rotating magnets.   We have found that these engines typically have 3 magnets, with 2 magnets 

mounted with one polarity, and the other one with another polarity.    The easiest way to use these magnets is to install the sensor with 

the printed side facing the magnets (as described below) then run the motor and see what RPMs are recorded after setting up the gear 

ratio.    If the RPM looks like it is only half of the correct value, double the gear ratio value you entered, to compensate for only one 
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magnet being in the right polarity.    We have received problem reports of RPM reading errors when the RPM sensor is 

mounted very near the magneto of spark engines, so we recommend mounting it 180 degrees away from the magneto, or as far away 

as possible. 

 

Installing the RPM Sensor 

 

Once the magnets are glued and completely dry, temporarily position the RPM sensor so that the side of the sensor with printing (or 

a colored dot) is facing the side of the magnets WITHOUT the red line.   The sensor now needs to be glued so that it is held 

rigidly into position.   Before gluing, put a small spacer (1-2 mm thick) between the sensor and one of the magnets to ensure proper 

spacing.      

 

If desired, a small piece of brass tubing can be glued or heatshrunk to the back of the sensor to ease mounting and increase stability. 

 

After the sensor is glued and completely dry, remove the small spacer and rotate the propeller to ensure complete freedom of 

movement.   Also make sure that the sensor won’t vibrate and come in contact with the magnets during driving.   If this happens, the 

sensor will be destroyed, and the Recorder could be damaged. 

 

Once these steps are complete, plug the Futaba style connector on the sensor into the recorder as shown in figure 1.     Note that a 

standard Futaba style servo extension cable can be used to lengthen the wire if needed. 

 

Using Existing RPM Sensors 

 

Several of our customers have been able to use existing RPM sensors, such as governors or turbine sensors,  with our products.    The 

following steps must be followed: 

 

1) Determine the “pinout” of the existing sensor.   Compatible sensors will have Power, Ground, and Signal connections.   The 

Recorder’s RPM pinout, from left to right, is:   Power (black wire), Ground (red wire), Signal (white wire).    

2) Devise a “Y” cable to connect your existing sensor to it’s connection, and also to the Recorder’s RPM connection.    NOTE: 

Power for the sensor should come only from the connection the sensor is normally plugged into.   So,  only Gound and Signal 

wires should be routed from the existing sensor to the recorder.    The power wire of the Y cable between the sensor and the 

recorder should be cut before connecting it to the recorder.    This is necessary to avoid connecting the power of the existing 

sensor connection to the Recorder’s power connection. 

3) Thoroughly test the system to make sure the sensor still works with whatever it was originally connected to, after Y’ing to the 

recorder. 

 

Installing a Secondary RPM Sensor 

 

A second MODIFIED RPM sensor can be plugged into the unused servo port nearest the switch on the recorder, for measuring RPM 

of multiple motors.    This RPM sensor must be modified by swapping the red and black wires in the RPM sensor plug.    Carefully 

pry back the plastic tabs that hold each pin in the plug, remove the red and black pins, and re-install them so that the pin order is RED, 

BLACK, WHITE.   The second RPM sensor plugs into the servo port with the red wire to the right, nearest the edge of the recorder. 

 

The second RPM channel is automatically set up with the same gear ratio as the primary RPM.      

 

The secondary RPM sensor is logged and displayed on the screens with the other parameters, as described below. 

 

NOTE: When using a secondary RPM sensor in the servo port, servo port monitoring will not work correctly.   It is a good idea to 

select “Do not calibrate servos” in the New Model Wizard if you plan on using multiple RPMs. 

 

NOTE: for the secondary RPM sensor to work, there has to be voltage from 4.5 to 6.5 V supplied to one or both of the servo inputs (as 

shown in Figure 1).     This is normally done with the optional Y Cables, a separate battery, or your BEC. 

 

 

Connecting the Recorder to Your Aircraft’s Servos and Receiver 
 

If you purchased the optional Servo ‘Y’ cables, you will be able to monitor your plane’s servo movements.    The custom, heavy duty 

‘Y’ cables with Universal connectors install in line between your throttle, rudder, aileron and elevator servos and your radio receiver. 

 

Normally, when the servo ‘Y’ cables are installed, the system is powered by the receiver through the ‘Y’ cables.  If you want to power 

the Recorder from a separate battery, meaning that you want complete electrical isolation between the Recorder and your receiver, you 

can power the Recorder with a small separate battery rather than using the  optional Y cables. 
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Connection of the ‘Y’ cables is simple:  connect the center (male) keyed connector of the ‘Y’ to one of the 4 keyed slots 

servo slots in the recorder (see Figure 1), connect the remaining male connector one of the channels on your receiver, and connect the 

female ‘Y’ connector to the servo which you previously connected to that channel of the receiver.    Note: It doesn’t matter which of 

the 4 keyed recorder slots you plug your ‘Y’ cables into – the Recorder Application will automatically detect which servos are 

connected where during application setup. 

 

WARNING:   Do not connect ‘Y’ cables to any other location on the recorder.   Doing so may damage the recorder or other 

components. 

 

Note:  The ‘Y’ cables included should be compatible with most of the currently available receivers, such as Futaba™, JR™, Tower™, 

and HiTec™.   The pinout of the ‘Y” cables is as follows:  Black = ground,   Red = power, White = servo signal. 

 

WARNING: It is your responsibility to make sure that your receiver and servos are pin compatible with the Y cables before 

connecting.   Serious damage could result to your receiver, servo or recorder if they are not compatible.  

 
Removing the Recorder from your Plane 
 

When you remove the Recorder, and are using the optional ‘Y’ cables.   your servos are still connected to your receiver so it’s not 

necessary to remove the ‘Y’ cables from the plane to operate it without the Recorder.     Be sure however that the connectors are kept 

from shorting.      

 

Note:   Additional ‘Y’ cables, RPM sensors and temperature sensors are available for purchase on our website if you wish to install 

and leave ‘Y’ cables in more than one plane.    This makes it very easy to use the same recorder with multiple Flights.     

 

Also, there is an external hookup kit available from Eagle Tree Systems which extends the USB, pushbutton and LED to the outside of 

your plane.   This allows for easy downloading and control of the Recorder without removing the canopy or wing. 

 

Installing and Using the Windows™ Application  

 

Installing the Windows Application 
 

The supplied Windows application is compatible with USB equipped PCs running Windows 98SE, Millennium, Win 2K, and Win 

XP.   The application is not compatible with Windows 98 Original Edition (Gold), or NT 4, even if the PC has USB support. 

 

NOTE:  the application included on CD with the unit was current at the time of manufacture.   Please check our Flight Support page 

on http://eagletreesystems.com to see if there is a newer version of the app which may have addressed issues you could encounter. 

 

To install the application, just place the CD in the CD-ROM drive.   If AutoPlay is enabled on your PC, the setup program should run 

automatically.   If it does not run, click on My Computer, click on the icon for your CD-ROM drive, and click on the “Flight Data 

Recorder” application icon in the drive window.  

 

Follow the Setup Wizard to install the Recorder application.   Once installation is complete, the Recorder may be launched either from 

its Desktop Icon, or by choosing the Recorder application from the Start->Programs->Eagle Tree Systems folder. 

 

Setting up the Recorder with the Application 

 
Once the application is installed, follow the above steps to launch it.   The first time the application is launched, the New Model 

Wizard will be invoked. 

 

The Wizard will prompt you to install the Recorder using the supplied USB cable.   

  

Warning:  Make sure you connect the custom USB plug with the correct polarity, and into the correct connector on the Recorder, 

as shown in Figure 1.  Not doing this could cause damage! 

 

When you do this for the first time, the behavior will be different depending on which version of Windows you are using: 

 

Windows 98™:  The Recorder and application are not compatible with Windows 98. 
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Windows 98SE™ and Windows Millennium™:   When the Recorder is first connected to the USB port, the New 

Hardware Wizard will likely appear.   Follow the steps in the Wizard, choosing the options to allow Windows to find the appropriate 

drivers for the Recorder – these drivers are built into Windows.   If the devices you already have on your computer haven’t required 

the installation of the USB drivers, Windows will prompt you for your Windows CD to copy over the drivers.     Once this process is 

complete, you may be asked to reboot the system.   Reboot at this point, then relaunch the Recorder Application, and the New Flight 

Wizard should start up again.    

 

Windows 2000 ™ and Windows XP ™:  When the Recorder is first connected to the USB port, Windows should automatically 

install the correct drivers without prompting you.   If you should receive a Windows prompt, however, do what it says. 

 

Once the Recorder is correctly discovered and installed by Windows, continue on with the New Flight Wizard, relaunching the app 

after reboot if necessary. 

 

Telling the Recorder what to Log 
 

Your Recorder has built-in data logging capability.    The first time you run the app, you will be prompted to choose what driving 

parameters you wish to log.   The more items you log, the less record time will be available.     A description of the parameters is 

below: 

 

Servo movements:   If one or more of these parameters is checked, the recorder will log the positions of the corresponding servos, 

assuming you have the optional ‘Y’ cables installed.   Choose these options if you want to see controller movements during your 

flight, etc.   .      

 

Servo Glitches:  If this option is selected, the recorder detects and logs three different types of servo glitches:  short servo pulses (less 

than 740uSec), long servo pulses (greater than 2.25 mSec) and missing servo pulses (no pulse for 100mSec).    The most common 

causes of glitches are low receiver or transmitter battery, driving out of range of your transmitter, or defective receiver.   Note that it is 

normal to see a series of glitch notifications right after the recorder or the transmitter is powered up. 

 

Receiver Battery Voltage:  Selecting this parameter causes the recorder to log your receiver’s battery voltage (or whatever battery is 

being used to power the recorder).    Note that it is normal to see rapid spikes in the receiver battery voltage on playback, but if you are 

seeing voltage drops below 4.5 volts on a regular basis, you should test your battery.    The Recorder constantly monitors battery 

voltage even if this option is not checked, and will shut itself down if the battery voltage consistently is below around 4.5 volts to save 

power for the receiver.    The recorder will log an error in this case.   The recorder will “reboot” if the voltage falls below 4.35 volts 

even for a short period, and logs an error in this case also.   Error logs are displayed in the “Notification Area” of the application 

during playback. 

 

Speed:  If this option is selected, the recorder logs the speed of your plane via the air pitot tube.  

 

Altitude: If this option is selected, the recorder logs the flight’s altitude with each sample. 

 

RPM: If this option is selected, the recorder logs the RPM of your Flight.    

 

Temperature 1:  Choose this option if you want to record temperature from the temperature sensor plugged into the “Tmp1” slot, 

sold separately. 

 

Temperature 2:  Choose this option if you want to record temperature from the temperature sensor plugged into the “Tmp2” slot, 

sold separately. 

 

Optional Accessories:  See the instruction manuals included with the optional accessories for information on logging these 

parameters.   Optional expanders for measuring Temperature, RPM, Servo movements, G-Force, Exhaust Gas Temperature, Electric 

Motor Current/Voltage, and other parameters are available from Eagle Tree Systems.  

 

Setting the Joystick Configuration Mode  
 

This setting only needs to be changed if you are logging servo movements.   The Recorder application defaults to US Mode 2 Joystick 

configuration, which is: 

 

• Left Joystick controls throttle and rudder, and Right Joystick controls elevator and ailerons. 

 

If you desire, you can select US Mode 1 via the Tools->Set Joystick Configuration Mode.  Mode 1 is: 
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• Left Joystick controls elevator and rudder, and Right Joystick controls throttle and ailerons.  

 

Setting the “Stop on Full” Feature 
 

After you complete the New Model Wizard for the first time, you will be prompted to choose whether you want the recorder to write 

over its data when its buffer becomes full, or to stop when the Recorder is full.    NOTE: You can change this setting later from the 

Tools menu. 

 

Setting the “Set Capture Rate” Feature 

 
The Recorder can be adjusted to capture data in during flight at five different rates.     The faster the capture rate, the more data is 

obtained, but at the expense of record time.     

 

NOTE: When using the variometer, a capture rate of 10 samples/second is strongly recommended! 

 

A note on record time:   The recorder uses advanced data compression to get the most data recorded as possible.   When your plane is 

sitting idle before or after flying with the battery turned on, the recorder is still capturing data, but since not much is changing very 

little data is recorded.   But when the plane is actively being flown lots of data is being recorded.    

 

Note: You can change this setting later from the Tools menu. 

 

Setting the “Choose What to Display” Feature 
 

The Recorder Application can display several flight parameters in both numeric and instrument format.   Select the parameters you 

wish the Application to display with this dialog box.    Note that some of the parameters require optional accessories, available from 

Eagle Tree Systems.    Also note that the display area is limited, so not all parameters can be displayed at once.   Numeric parameters 

take up less space than instruments, so more numeric parameters can be displayed at once. 

 

Note:  Select the “Metric” checkbox on this dialog if you want metric operation.   Also, you can change this setting later from the 

Tools menu. 

 

Setting the RPM to Motor Revolutions Parameter 

 
If you have the optional RPM sensor, for the Recorder Application to correctly determine the RPM of your motor, you must tell the 

application how the rotation of the motor relates to the rotation of the magnets.   The first time you run the app, you will be prompted 

to enter this information. 

 

Enter the number of times your motor turns with each rotation of the magnets as described in this dialog box.     

 

Note: You can change this setting later from the Tools menu. 

 

Setting Metric or English Units 
 

Metric or English units are selected via the Windows Recorder Application (the App).    The default setting is English units.   To 

change this, Click “Tools, Choose What to Display” in the app, and click on “Display In Metric.”    This causes both the App display 

and the Seagull LCD display to switch to metric. 

NOTE: whenever you change this parameter,  you must re-download data to the Seagull Dashboard, as described in “Seagull 

Dashboard Data Setup Utility Instructions” below. 

 

Seagull Configuration Wizard 
 

To configure the Seagull system, plug the USB cable into your PC and the Data Recorder, and launch the App and select “Tools, 

Seagull Setup Wizard.”   This wizard will guide you through the rest of the installation process.   See the below instructions on 

configuring specific items in the Wizard: 
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Seagull Transmitter Type:  Select either the FCC US Transmitter (red case) or the EU transmitter (gold case) 

depending on which system you have. 

 

Seagull ID:   The Wizard automatically generates an ID for your Seagull system, which you can change in the wizard.   The Seagull 

ID uniquely attaches your Seagull Transmitter to your Dashboard.    This attachment means that it is unlikely that other Seagull 

systems at your site will interfere with your system, and it also keeps your data private to some degree.    Note that the Seagull system 

will not operate if the Seagull Transmitter and Dashboard are set to different ID’s.     

 

Note:  The Dashboard ID is displayed in Hexadecimal in the lower right-hand side of the LCD screen at Dashboard power up. 

 

Set Beep on Seagull Keyboard Press:   Check this wizard box if you want a short beep to sound on each press of the Dashboard 

buttons.   Note that in this mode, selecting Mute All will silence these beeps. 

 

Seagull Power Level (FCC transmitter only):  The Seagull Transmitter supports operation at low (around 8-12 milliwatt) and high 

(around 200 milliwatt) power levels.   Normally low power is good for indoor use, and high power may be required for outdoor use.      

Warning:  Always range check your model after changing power levels! 

 

Connecting the Dashboard to USB:  When the Wizard asks you to Connect the Seagull Dashboard, disconnect the Recorder from 

the USB connection, and connect the Dashboard as described in the “Seagull Dashboard Receiver Instructions” section above.   Note:   

Follow the Wizard instructions carefully – if the computer needs to reboot the first time the Dashboard is installed, do so and relaunch 

the Wizard after reboot. 

 

After the Dashboard is successfully discovered by your PC, “USB Mode Active” should display on the LCD window.   If this does not 

happen, see the Troubleshooting section below. 

 

Launching the Dashboard Data Setup Utility:  After the Dashboard is discovered by the PC, the Next button of the Wizard should 

ungray, and hitting Next take you to the final page of the Wizard.   This page has a button to launch the Dashboard Data Setup Utility.   

See the below section on running this utility.   Once the utility is successfully run, the Finish button of the Wizard will ungray. 

Seagull Dashboard Data Setup Utility Instructions 
 

This utility (the Utility) will appear the first time you run the Seagull Configuration Wizard, and can be re-run by selecting “Tools, 

Edit Seagull Display” in the App.     This utility is the tool used to bring your Seagull Dashboard to life – it gives you the capability of 

configuring all of the items displayed on the LCD screen, setting up alarms, and configuring the Climbrate Alarm settings (Flight 

Systems).    

 

Figure 4 shows the main page of the Utility.    The Utility main page is divided into the following section: 

 

Select Data Parameter to Configure on the Dashboard LCD:   This section contains the tools to select what, how and where 

parameters are displayed on the LCD pages. 

 

Figure 6 provides a table of the parameters that can be configured with your system. 

 

To select and configure a parameter,  choose the parameter to be configured in the “Select Feature to Display” window.   A “o” next to 

an item indicates that this item is already selected for display, and choosing it will allow you to edit the item.    After selecting the 

parameter, click the “Enable this parameter…”  checkbox to enable the parameter to be displayed/configured, or uncheck it to remove 

it from the list.     

 

Once the parameter is enabled, choose where the parameter will be displayed by choosing the location in the “Select Display 

Location” window.   A “o” next to the location chosen means it is already in use by this or another parameter.   Choosing a location 

that is in use already will cause the parameter using it to be disabled. 

 

The window labeled “Enter the label to display..” in this section displays the 3 digit label that will be displayed beside this parameter 

on the LCD.  You can change this 3 digit label to be whatever you want.    For example, if Temperature Sensor 1 was attached to your 

Cylinder Head, you might label this parameter “CHT.” 

 

NOTE:  If the data for each parameter grows large, such as a large RPM, the middle character in the 3 digit label will be eliminated to 

show all the numeric digits in the parameter.   For example, “RPM 0” would become “RM 40342” in this case.     

 

Set up alarms (if any) to be triggered by values of the above parameter:  This section contains the tools to set up audible and 

visual alarms for many of the displayed parameters. 
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NOTE: See the “Servo” section below for information on Servo setup. 

NOTE:  If you have a Flight System and select Climbrate, see the “Configuring Climbrate Alarms” section below. 

 

To enable a “High Alarm” for a parameter, meaning that the alarm should activate if the parameter exceeds the set value, check the 

High Alarm Enabled button. 

 

To enable a “Low Alarm” for a parameter, meaning that the alarm should activate if the parameter falls below the set value, check the 

High Alarm Enabled button. 

 

NOTE:  only a high or a low alarm can be configured for each parameter (not both). 

 

To enter the alarm value, type the high or low threshold in the “Enter the Alarm Trigger Value” window.   For values, such as RX 

voltage, with a decimal place, enter the fractional part in the box to the right of the decimal point.   For example, to set an alarm if 

your RX voltage drops below 4.8 volts, enter 4 and 8 in the two boxes.    

 

See the Parameter table in Figure 6 for high and low alarm limits.   NOTE: when an alarm is triggered, a “!” appears to the right of the 

parameter label on the LCD, to indicate the parameter is in an alarm state. 

 

If you wish to have an audible beep sound when the alarm is triggered, configure the beep alarm as follows: 

 

• Select the number of beeps to sound in the “Number of Beeps” window. 

• Select the beep length in the “Length of each Beep” window. 

• Select the length of the “silence” between each of the beeps in the “Length of silent pause between beeps” window. 

 

If you wish the beeps to repeatedly sound when the alarm condition occurs, click on the “Check here to cause the alarm beeps to 

sound continuously…” checkbox.    If you wish the alarm to only sound once when the condition occurs, uncheck this box.   Note that 

when the alarm condition goes away, and then recurs, the alarm will sound again in both these cases.   See the muting section in the 

“Seagull Dashboard Receiver Instructions” above for information on muting the alarms. 

 

If you want to have the Dashboard switch to the LCD page that has the alarming parameter, check the “Check here to automatically 

Switch…” checkbox. 

 

NOTE:   If two or more alarm conditions occur simultaneously, only the last occurring condition will be signaled.   If the last 

condition to trigger an alarm goes away, the second to last currently active condition will be signaled, etc. 

 

Once all the parameters you wish to display are configured, you can review the parameters by clicking the Preview button as shown in 

Figure 5.   The Preview window is a handy way to see which parameters are configured on which LCD page locations.   A “***” in a 

page location indicates that no parameter is displayed in that location. 

 

Once the parameters are configured to your satisfaction, click OK, which will download the settings to the Dashboard.   Note that you 

can change the parameters at any time by following the above steps. 

 

Note:  If you wish to clear all previously configured parameters, hit the Clear button on the bottom of the utility. 
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                                         Figure 4        Figure 5 

 

Configuring Variometer Alarms 
 

If you wish to configure climbrate and/or sinkrate alarms for variometer support, click the Variometer button in the alarms section.   

Note that the Climbrate button will only appear when the Climbrate parameter is selected and Enabled.   Note also that when the 

Variometer parameter is enabled, the Configure Variometer page will automatically appear. 

 

Carefully read the instructions on the Configure Variometer page.    This page should be self explanatory.   The audible 

climbrate/sinkrate alarms are configured in basically the same way that other alarm parameters are configured.   One difference is that 

both climbrate and sinkrate alarms can be simultaneously programmed. 

 

Note that the altitude value displayed (if the altitude parameter is selected for display) is by default averaged and updated once during 

each climbrate measurement time interval.   If you wish to display the raw, unaveraged altitude value, uncheck this box.   Note that the 

altitude may “jump around” a bit if raw mode is chosen.    

Servo Display on the Dashboard 
 

If you calibrated your servo movements with the App during Recorder setup, the Seagull should display the correct names of your 

servos, i.e., “Ailerons.”    If you did not calibrate,  servos will be labeled “Servo 1”, etc. 

 

If you calibrated, the data values displayed for your servos should be as follows: 

 

Rudder, Ailerons, Elevator:  -100 to 100; Throttle: 0 to 100 (with negative values for idle trim down) 

Using your Seagull in Laptop Live Mode 
 

If you have a laptop at your site, or wish to see live data with your model on the bench, the App can be used to view the Seagull data 

parameters live in a “big screen” format, with almost infinite recording capability! 

 

To use Live Mode, first select “Tools, Choose What to Display” in the App, and set up the parameters you want to display.    Two 

Seagull specific items are available to display, as well as the other parameters: 

 

Seagull Signal Strength – this item shows the strength of the real-time signal coming from the Seagull Transmitter. 

Seagull Packet Percent – this item shows the percentage of packets that were successfully received from Seagull.     
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To invoke Live Mode, first ensure that your Dashboard is receiving data from the transmitter.   Then, connect the 

Dashboard to USB, and click the Live Mode button on the App.    A window may display asking you whether to record the Live Mode 

data.    After choosing this option, Live Mode should start and display the live parameters.      

 

Note:  several of the Live Mode parameters are zeroed when Live Mode is started.   Stop and restart Live Mode if the parameters did 

not correctly zero. 

 

Note: whenever a packet is missed, the previous packet is duplicated in the Live Mode recording.    The duplicated packets are marked 

as duplicated in the “error” fields of the recording – these are visible when viewed in Excel.   See the Recorder manual for more 

information on viewing the files in Excel. 

 

Note: if the 9 volt battery is installed in the Dashboard, the Dashboard will be powered by the battery even when the USB plug is 

connected.   If you wish to monitor or record very long runs with Live Mode, turn off all power to the Dashboard and remove the 9 

volt battery.   Then, the Dashboard will be powered by USB. 

 

Parameter 
(Units) Standard? Min Value Max Value Alarm Low Alarm High 

Max 
Recorded 

Servo1 No Varies varies N/A N/A No 

Servo2              No Varies varies N/A N/A No 

Servo3 No Varies varies N/A N/A No 

Servo4 No Varies varies N/A N/A No 

RX Volts (V) Yes 4.4 7.5 4.5 7.4 No 

Temp 1 F, (C) No 0 424 (200) 1 423 (199) Yes 

Temp 2 F, (C) No 0 424 (200) 1 423 (199) Yes 

Motor Voltage 
(V) No 0 50 1 49 Yes 

Motor Current 
(A) No 0 90 1 89 Yes 

Altitude Ft, (M) Yes -2000 (-600) 30000 (9000) 0 29999 (8999) Yes 

Speed MPH, 
(KPH) Yes 0 290 (466) 1 289 (465) Yes 

RPM No 0 65535 1 65534 Yes 

G-Force X (G) No -38 38 0 37.9 Yes 

G-Force Y (G) No -38 38 0 37.9 Yes 

EGT 1 F, (C) No 0 2000 (1093) 1 1999 (1092) Yes 

EGT 2 F, (C) No 0 2000 (1093)  1 1999 (1092) Yes 

Milliamp-Hours No 0 9999 N/A N/A No 

Climbrate  FPM, 
(MPM) Yes -9999 (-2999) 9999 (2999) -510 (-153) 510 (153) No 

Seagull Signal 
(%) Yes ~45 100 N/A N/A No 

Received Packet 
% Yes 0 100 N/A N/A No 

    Figure 6 – Table of Seagull Parameters 

 

Using the Recorder/Data Logger 
 

Please read the important information below on Recorder operation before using it in your plane. 

 

The Recorder’s LED 
 

The Recorder’s LED serves several purposes.   When the Recorder is powered on when installed in your Flight, the LED flashes a 

number of times to indicate your 4.8 or 6 volt battery’s charge state at power-up time.   Five flashes indicates a fully charged battery, 

and three or fewer flashes indicates that the battery is likely not safe to use.   Loading can affect these readings, of course. 
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IMPORTANT:  The Recorder’s battery indicator should be used as a guide only:  you need to verify that the 

LED gives accurate results with your system, and you need to make sure that your battery’s charge state is sufficient before 

flying under the appropriate loads.    

 

WARNING:  The Recorder gives charge level indication for both 6 volt and 4.8 volt batteries, and attempts to detect which is 

installed automatically.     

Be aware that if you have installed a 6 volt battery and it goes so dead that it looks like a fully charged 4.8 volt battery, the 

Recorder will flash five times  

because it thinks the battery is fully charged, though the 6 volt battery is actually nearly dead!! 

 

Once the Recorder is powered up in your Flight, it will either flash one or two times every second or so.  This flash rate is longer or 

shorter depending on the capture rate.   This flashing indicates the following: 

 

One Flash -  The recorder is actively recording.   This is the normal power-up state. 

 

Two Flashes – The recorder is paused.   This has happened either because the Recorder’s data buffer is full and you have selected the 

“stop on full” mode described above, or you have manually paused the Recorder as described below in the Recorder Button section. 

 

Three Flashes – The Recorder is connected to your PC’s USB connector, and has been recognized by the PC.  

 

The Recorder’s Pushbutton 

 
The small red pushbutton on the Recorder serves two purposes. 

 

When depressed and released quickly, the button toggles between Pause and Record modes.   The LED will indicate the current mode 

as described above. 

 

When the button is depressed and held in for several seconds, the LED will flash rapidly, the Recorder’s Data Buffer will be cleared, 

and the Recorder will flash to indicate battery voltage as described above. 

 

NOTE:  All data within the Recorder will be lost when the Recorder is reset in this manner! 

 

After You’ve Flown 
 

After flying with the Recorder, you can either remove the Recorder from your plane and take it to your PC, bring the plane with the 

Recorder still in it to your PC, or (if you’re lucky) use a Laptop and connect to the Recorder in the field. 

 

After you connect the Recorder to your PC’s USB interface, the LED should indicate USB connectivity with three repeating flashes 

as described above.     

 

Once the Recorder is connected, launch the Application and click on the Download From Recorder button.     This will load the 

Recorder’s Data Buffer into the Application for playback and saving. 

 

Use the play controls to play back the data.   Note that the Slider can be dragged with the mouse by clicking and holding it then 

moving it to the desired position. 

 

The application displays the following information: 

 

• Notifications – this window displays messages about the flight.   The three most common messages are: 

o Startup/Reset Detected – this indicates that the Recorder has been turned on at the time specified 

o Recorder low battery restart – this indicates that the Recorder has ‘rebooted’ because the power momentarily 

dropped below 4.35 volts.   See the troubleshooting section if you frequently see this message. 

o Glitch detected – these messages tell you what type of glitch was detected, and on what servo the glitch occurred.  

The most common causes of glitches are low receiver or transmitter battery, flying out of range of your transmitter, 

or defective receiver.   Note that it is normal to see a series of glitch notifications right after the recorder or the 

transmitter is powered up. 

• Length/Progress – when stopped, this readout indicates the total recording length.   When playing back, this meter indicates 

current time into the flight. 

• Battery Voltage – this instrument indicates the current battery voltage during playback. 
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• Graphical and/or Numeric Temperatures – The application can display up to two Temperature readings in 

either instrument or numeric format. 

• Graphical and/or Numeric RPM – The application displays RPM readings in either instrument or numeric format. 

• Graphical Joysticks – Joystick positions are indicated via graphical joysticks. 

• Graphical and/or Numeric Speed – The plane’s speed, as computed from the air pitot tube can be displayed graphically and 

numerically. 

• Graphical and/or Numeric Altitude – The plane’s altitude is displayed when these options are selected. 

 

Other display options are available with optional equipment from Eagle Tree Systems. 

 

A note on Multiple Flights   
Depending on the length of your flights, it is often possible to record multiple flights into the recorder without having to clear the 

buffer or overwrite data.  Playback of multiple flights can be a little confusing.   One thing that helps you to separate runs is the 

"Recorder Startup" message that displays in the notification area.   Whenever this displays, the recorder has been powered down and 

turned back on. If you turn off and on your receiver between flights then you can know when one flights ends and the next one begins. 

 

Saving Flight Files 
After downloading flight data, if you wish to save the data to play back later or to share with friends, save the file with the File->Save 

Recorder File menu.   Note that the file is saved with a .FDR extension by default. 

 

Graphing/Spreadsheet Compatibility 
The Recorder application has extensive graphing capability built in.   Just click on “Graph Data!” on the toolbar to graph loaded data.    

Click on the HELP button on the graphing page for more information on graphing.   

 

Also, the Recorder’s Data File is compatible with Excel ™ spreadsheet software, and perhaps other spreadsheet brands.   Using 

Excel™ is useful for graphing the data output from the recorder. 

 

To load in Excel, save the data file from File->Save Recorder File, and in Excel™ choose File->Open, and select “All Files” in the 

“Files of Type” box.   Navigate the Excel dialog box to the location you saved the .FDR data file, and click on the filename.    Excel 

should then bring up the “Text Import Wizard”.   Choose the “Delimited” option, and on the next page choose “Delimited with 

Spaces”.   The data should then load correctly in Excel.   

 

The format of each line of data in the file is: 

 

First Line:  Plane Name 

Second Line: Data about your plane’s setup.   This line is needed to allow sharing of your flight files with others. 

Third line:  header indicating what each of the fields represents.  These columns are: 
Aileron Elevator Throttle Rudder Altitude RPM Speed Rec-Bat*10 Temp1*10 Temp2*10 Amps*100 PackVolt*100 GForceX GForceY ThermoA 

ThermoB IsEvent EventError EventData Timestamp 

  

The first four entries indicate servo positions.    The values correspond with the length of the servo pulse for each servo.   A lower # 

means the pulse was shorter.   A value of zero corresponds to a length of about 740uSec, and a value of 254 means about 2.25mSec.    

 

 

If IsEvent is 1, the record contains event data as well as regular data.   Typical events are power-up (restart), and servo glitches. Ignore 

the non-event fields when IsEvent is set to 1. 

 

Event Codes in the “EventCode” field are as follows (the first one is 0).  Note that “internal” errors should be reported to Eagle Tree 

Systems: 

  

ERROR_BEGINPOINTER_INVALID - internal, 

 ERROR_ENDPOINTER_INVALID - internal, 

 ERROR_INIT_POINTERS_INVALID - internal, 

 ERROR_INITIALIZE_FAILED - internal, 

 ERROR_CANT_SEND_HEADER - internal, 

 ERROR_CANT_SEND_ANALOG_PACKET - internal, 

 ERROR_CANT_SEND_DATA_PACKET - internal, 

 ERROR_BATTERY_LOW – battery has fallen below a safe level for an extended period of time, 

 ERROR_RESTART – the recorder has been restarted normally, 

 ERROR_NESTED_INT_DISABLE - internal, 

 ERROR_ILLEGAL_INT - internal, 
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 ERROR_LOW_BAT_RESTART – the recorder has been restarted due to a brownout, 

 ERROR_SERVO_GLITCH_MISSED – a servo pulse was missing, 

 ERROR_SERVO_GLITCH_SHORT – a servo pulse was shorter than 740uSec, 

 ERROR_SERVO_GLITCH_LONG – a servo pulse was longer than 2.25mSec, 

  

Timestamp indicates when each record was collected.   The timestamp is in milliseconds. 

 

Email us if you need more information on the file format. 

 

Troubleshooting 
 

Below is a list of problems that may be encountered, and steps to remedy them.   If your particular issue is not addressed by the 

below, see the Flight Support page on http://www.eagletreesystems.com or email info@eagletreesystems.com.   Include a full 

description of your problem, your machine configuration, brands/models of receivers, transmitters and servos, application and 

firmware version if possible (from Help->About in the app) and any other relevant details. 

 

Issue:  My Dashboard is receiving data, but it doesn’t look like correct data. 

Solution: Some parameters, like altitude, airspeed and current, are “zero calibrated” each time the Dashboard is turned on.   If these 

parameters are not zeroed, try turning off and on the Dashboard. 

 

Issue:  My altitude or airspeed values seem to drift, even when the model is sitting still 

Solution:  Some slight drift may occur on the ground.    Note that for airspeed, which is related to the square of pressure, slight drift 

from zero will not affect your higher speed readings much.  For example, if your Dashboard is displaying 9 MPH when not moving, 

the error at 50 MPH would be closer to 1 MPH, rather than 9 MPH. 

 

Issue:  I am unable to successfully complete an “antenna down” range check with the Seagull Transmitter running.   I am seeing servo 

jitter or observing reduced range during range checking. 

Solution:  First, verify that the problem does NOT happen with the Recorder/Transmitter removed from the plane. 

Solution:  Try low power transmit mode if you are not using it (requires PC connection).   Note that low power mode is the default. 

Solution:  Try operating the Recorder/Transmitter without any recorder cables connected to your radio RX.   This will require a 

separate small battery to power the Recorder, and servos cannot be monitored in this mode. 

Solution:   

As a last resort, Ferrites or torroids can be installed at various locations.   This would normally not be necessary. 

• Ferrite cores can often be used to filter out the RF interference.   Snap-on RF ferrite cores are available from Eagle Tree 

Systems, Radio Shack or other sources.    Often a single ferrite snapped around all the wires leading from the motor will 

eliminate this problem.   Or, the wires can be wrapped a few times through a hollow torroid. 

• If a single ferrite does not remedy the situation, an additional ferrite snapped around all the servo Y cables provides 

additional filtering.   

 

Issue: My Dashboard display is hard to read, or very dim.    

Solution:  See the “Display Contrast” information in the Seagull Dashboard section above. 

Solution:  Replace the Dashboard battery. 

 

Issue:  My Dashboard works briefly, then shuts off. 

Solution:  Replace the Dashboard battery. 

 

Issue:  My PC does not recognize the Recorder. 

Solution:  Try to eliminate the problem in the following ways: 

o Disconnect all other USB peripherals from your PC (if possible) and try the Recorder again. 

o Try the Recorder on a different PC.   If it works, there may be a misconfiguration with your PC. 

o Try the Recorder with a different USB cable, if you have one.  If this works, your cable has been damaged. 

o Try rebooting your PC – occasionally USB support gets disabled with some PCs. 

o Try the other USB connector on you PC if it has two. 

o Ensure that USB is enabled within your Operating System by checking in Device Manager.   You’ll need to see your 

Windows™ documentation to determine how to do this on your particular OS version. 

 

Issue:  RPM is not working correctly 

Solutions:  

• Make sure that the parameter in the "Tools->Calibrate Motor RPM" is not set to zero.   If this is zero, RPM will read zero. 

• Make sure you have the writing on the RPM sensor facing away from the red lined side of the magnets. 
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•  Make sure that under Choose What to Log in the app, you have checked RPM. 

• Make sure that the RPM sensor is plugged into the correct slot on the recorder (should be the bottom slot next to the temp 

sensors). 

• Connect the recorder to the computer and launch the app.   Then, choose Tools->Live Mode.   Make sure that the RPM gauge 

is displayed, and spin the magnets, or wave the magnets by hand in front of the sensor.  Try both sides of the magnets and 

both sides of the sensor.    See if the RPM reading jumps.   If it does not, email support@eagletreesystems.com. 

 

Issue:  My plane shows an airspeed or variation during warm-up on the ground as I rev the throttle. 

Solution:  This problem will happen when the Pitot Tube’s opening is being hit by prop-wash.   The solution is to move the tube 

farther away from prop airflow.   Note that slight variations in speed (and even a reading of around 9 MPH, which is the lowest speed 

detectable, when the plane is stationary) is normal. 

 

Issue:  I have a fully charged battery, but the recorder frequently shows “Low Battery Restart” Notifications when playing back data. 

Solution:   The recorder shuts down immediately if the power goes below about 4.5 volts for more than a few milliseconds, and logs 

this occurrence when the power returns to above 4.5 volts.   If your battery’s voltage frequently drops this low, you may be 

underpowered, and may want to consider getting a bigger battery.   It is however not too unusual for this to happen with 4 cell packs 

and some servos with acrobatic flying.   If this becomes a significant problem, it can be eliminated by moving to a 5 cell pack or 

adding a secondary battery with the battery harness as described above. 

 

Issue:  I get no communication between the Dashboard and the Recorder.    The “No Signal” message appears on the dashboard 

constantly, or flashes on the dashboard every few seconds. 

Solution:  Make sure the Seagull Transmitter is plugged into the correct Recorder slot, and that the plug polarity is correct 

Solution:  Make sure that the Recorder light is flashing one repeated flash (or two repeated flashes if the Recorder buffer is full) 

Solution:  Make sure that the Recorder is not connected to USB. 

Solution:  Turn vehicle’s power off, WAIT 10 SECONDS, turn your vehicle’s power back on, and then turn your Dashboard off and 

on. 

Solution:  Make sure the Seagull ID is correctly set in both the Recorder and the Dashboard, by running through the Seagull Setup 

Wizard again.  

Solution:  Make sure you have chosen a Recorder sampling rate that is Seagull compatible.   This is set in the App by choosing 

“Tools, Choose Capture Rate” with the Recorder connected.   10 Samples/Second is recommended. 

Solution:  If you have purchased the Dashboard or Recorder at different times, or otherwise cannot get them to communicate 

correctly, please follow the below instructions: 

1) Install the latest Windows application from the Support page of our website. 

2) Connect the Dashboard to USB, and run “Tools, Choose firmware control.”   If the “Update” button appears, update the firmware, 

and follow all the prompts.    

3) If the Update button does NOT appear in step 2, choose “Tools, Choose Parameters to display on Wireless Dashboard LCD”, 

select any parameter to display, and hit OK. 

4) Disconnect the Dashboard from USB, and connect the Recorder to USB.   Then, select “Tools, Firmware Control” and click the 

Update button if it appears.  Then, click OK. 

5) Choose “Tools, Seagull Wireless Dashboard Setup Wizard” and run through the Wizard, making sure you select the correct type 

of Transmitter you have. 

6) With nothing but the transmitter connected to the correct port in the recorder, and a battery connected to one of the servo slots of 

the recorder, verify that the recorder and dashboard are now communicating. 

7) If you still do not get proper communication, email us at support@eagletreesystems.com 

 

Issue:  I get periodic “No Signal” messages on the Dashboard during vehicle operation 

Solution:  if you are operating at low power mode, try high power mode.   Make sure you range check after changing power modes! 

Solution:  If others are operating Seagull systems in your area, try a different Seagull ID 

Solution:  Try to make sure that your Seagull transmitter antenna is mounted vertically.    This can often improve range. 

 

 

FCC Information 
 

Recorder FCC Information 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not 

cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired 

operation. 

 

Seagull Receiver FCC Information (For 900 MHz and 2.4 GHz Systems) 
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Eagle Tree Systems   SEA-01 (900 MHz, 200mW System) 

Contains FCC ID: OUR-9XTEND (900 MHz, 1 Watt System) 

Contains FCC ID: OUR-XBEEPRO (2.4 GHz System) 
                                   

     Tested to Comply With FCC Standards 
 

FOR HOME OR OFFICE USE 
 

FCC Radiation Exposure Statement Regarding the FCC Certified 900 MHz and 2.4 GHz 

Transmitters 
 
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.   This equipment must be 

operated with minimum distance of 20cm between the radiator and your body. 

 

The Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. 

 

FCC Caution 

 
Any changes or modifications not expressly approved by the party responsible could void the user’s authority to operate this 

equipment. 

 

Radio Interference and FCC Information  
 

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC  

Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 

equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, 

may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a 

particular installation.  

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment 

off and on,  

the user is encouraged to try to correct the interference by one or more of the following measures: 

 

--Reorient or relocate the receiving antenna. 

--Increase the separation between the equipment and receiver. 

--Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

--Consult the dealer or an experienced radio/TV technician for help. 

Specifications 
 
FCC 900 MHz, 200mW Transmitter 

Frequency Range: 902 – 928 MHz 

Operating Range (Line of Sight): up to 1.2 miles w/included antenna, up to 3.6 miles with RX Yagi 

FCC Approval: 15.247 Frequency Hopping Spread Spectrum 

Maximum Output Power: approx 200 mWatt 

Dimensions: approx 2-3/4” x 1-1/4” x ¼” 

Weight: approx 0.5 oz (Transmitter only) 

Temperature Range: 0 – 140 degrees F 

TX Antenna: Thin, flexible stainless whip 

Power:  Power taken from Recorder/Receiver battery 

Current Draw: Transmitter + Recorder, average < 70 milliamp 

 

FCC 900 MHz, 1 Watt Transmitter 

Frequency Range: 902 – 928 MHz 

Operating Range (Line of Sight): Up to 14 miles (22 km) w/ included antenna, up to 40 miles with RX Yagi 

FCC Approval: 15.247 Frequency Hopping Spread Spectrum 

Maximum Output Power: approx 1 Watt 

Dimensions: approx 1.44” x 2.38” x 0.20” (3.65 cm x 6.05 cm x 0.51 cm)  

Weight: approx 0.8 oz (Transmitter only) 
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Temperature Range: 0 – 140 degrees F 

TX Antenna: Articulating Rubber Antenna with MMCX Pigtail 

Power:  Power taken from Recorder/Receiver battery 

Current Draw: Transmitter + Recorder, average 250 milliamp 

 

FCC/CE 2.4GHz, 100mW Transmitter 

Frequency Range: 2.4GHz 

Operating Range (Line of Sight): Up to 2 miles (3 km) w/ included antenna 

FCC Approval: Direct Sequence Spread Spectrum 

EU Approval: ETSI, CE 

Maximum Output Power: approx 100 mW 

Dimensions:     1” x 1.5” x 0.350” (25 mm x 37 mm x 9 mm) 

Weight: approx 0.3oz  (8 g) (Transmitter only) 

Temperature Range: 0 – 140 degrees F 

TX Antenna: short wire 

Power:  Power taken from Recorder/Receiver battery 

Current Draw: Transmitter + Recorder, average 100 milliamp 

 

EU/CE 433MHz, 10mW Transmitter  

Frequency Range: 433 – 434 MHz 

Operating Range (Line of Sight): up to 1000m w/included antenna, up to 3000m with RX Yagi 

Manufacturer: LPRS, UK 

Maximum Output Power: approx 10 mWatt 

Dimensions: approx 38 x 25 x 4mm 

Weight: approx 6 grams (Transmitter only) 

Temperature Range: -40 to 85 degrees C 

TX Antenna: Thin, flexible stainless whip 

Power:  Power taken from Recorder/Receiver battery 

Current Draw: Transmitter + Recorder, average < 60 milliamp 

 

Receiver 

RX Antenna: Thin, flexible stainless whip 

Temperature range: 0 – 140 degrees F 

Battery: Standard 9V (or other 5V to 16V battery pack) 

Display: 16x2 character LCD 

Pushbuttons: 4 

USB connection: Yes 

 

Recorder 

Airspeed: around 2 MPH minimum, approximately 290 MPH maximum 

Altitude: 0 to approximately 32000 feet, in approximately 1 foot increments 

Operational Voltage: 4.35V to 7.0V (1 Watt transmitter requires 5V to 5.75V) 

Weight:  Recorder and Pitot tube, approximately 1 oz. 

Temperature:  Dual inputs, 0 degrees F to 424 degrees F 

RPM range: approx 100 RPM to 50,000+ RPM 

Units supported:  English and Metric 

Measurements:  1.97” x 1.38” x 0.67” 

Record Time:  Varies with sample rate, parameters being recorded, and “activeness” of flight.  Anywhere from around 20 minutes to 

hours is attainable depending on these settings.  

 

Limited Warranty 

Eagle Tree Systems, LLC, warrants the Flight Data Recorder to be free from defects in materials and workmanship for a period of one 

(1) year from the date of original purchase.    This warranty is nontransferable.   If your unit requires warranty service during this 

period, we will replace or repair it at our option.   Shipping cost to us is your responsibility. 

To obtain warranty service, contact us by phone, fax or email to request an RMA number.   No returns will be accepted without this 

number.      

This limited warranty does not cover:  
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• The Software included with the Flight Data Recorder.   See the Software license agreement for more 

information on Software restrictions. 

• Problems that result from:  

o External causes such as accident, abuse, misuse, or problems with electrical power  

o Servicing not authorized by us  

o Usage that is not in accordance with product instructions  

o Failure to follow the product instructions  

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY 

FROM STATE TO STATE (OR JURISDICTION TO JURISDICTION). OUR RESPONSIBILITY FOR MALFUNCITONS AND 

DEFECTS IN HARDWARE IS LIMITED TO REPAIR AND REPLACEMENT AS SET FORTH IN THIS WARRANTY 

STATEMENT. ALL EXPRESS AND IMPLIED WARRANTIES FOR THE PRODUCT, INCLUDING, BUT NOT LIMITED TO, 

ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 

PURPOSE, ARE LIMITED IN TIME TO THE TERM OF THE LIMITED WARRANTY PERIOD AS DESCRIBED ABOVE. NO 

WARRANTIES, WHETHER EXPRESS OR IMPLIED, WILL APPLY AFTER THE LIMITED WARRANTY PERIOD HAS 

EXPIRED. SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS 

LIMITATION MAY NOT APPLY TO YOU.  

WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS LIMITED WARRANTY OR FOR 

CONSEQUENTIAL OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, ANY LIABILTY FOR THIRD-

PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST 

DATA OR LOST SOFTWARE. OUR LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE PRODUCT 

THAT IS THE SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH WE ARE RESPONSIBLE.  

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 

SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.  

 

Product Warranty Registration 

 
Registering your product means that we can send you important updates and other notifications.  Please fill out this form (or a copy) 

and mail or fax it to Eagle Tree Systems.   Or, email the info to sales@eagletreesystems.com.   Note that if you purchased your item 

directly from Eagle Tree Systems, this is not necessary. 

 

 
 

Eagle Tree Systems Warranty Product Registration: 

 

Name:__________________________________________________________________________ 

 

Address: ________________________________________________________________________ 

 

Phone: ________________________________  Email: ___________________________________  

 

Product(s) Purchased: ________________________     Date Purchased:______________________ 

 

Where did you purchase your product?_________________________________________________ 

 

Where did you hear about our product? _______________________________________________ 

 

Any features or additions you would like to see? _________________________________________ 
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